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Chapter 1
Ù»¬¬·²¹ Í¬¿®¬»¼

This guide was designed to provide complete installation instructions that 
enable you to fully utilize the Business Objects suite of products and the 
CMS Universes while maximizing the security features required in today�s 
business environment. Read this entire guide before beginning the 
installation.

Installation Checklist
� Read the installation guide before proceeding.
¡ Check system requirements.
¡ Install Supervisor on the supervisor�s computer.
¡ Create a second Supervisor login profile.
¡ Create the BOMain Key.
¡ Create users for Business Objects.
¡ Install Business Objects on a client computer.
¡ Copy over the BOMain Key to the client computer.
¡ Download all Universes from the CGC web site to the Universe folder 

(e.g., C:\Program Files\Business Objects\Business Objects 
5.1\Universe).

¡ Export the Universes to the Repository.
¡ Read the Release Notes on the Computer Guidance Corporation 

website.



î Þ«­·²»­­ Ñ¾¶»½¬­ ëòïòç ×²­¬¿´´¿¬·±² Ù«·¼»

System Requirements

Hardware
¡ IBM®-compatible machine with a P4 processor with 1.2 GHTZ or 

higher
¡ At least 512 MB of RAM; 256 MB of RAM is recommended
¡ Hard drive with 10 GIG of disk space
¡ CD-ROM drive

Ò±¬» If using distributed Business Objects, it is recommended that the 
nodes communicate over a dedicated network to handle the extra 
network traffic. Verify that the Domain Name Service is properly 
configured.

Software
¡ Microsoft XP Service Pack 1 or Service Pack 2
¡ Microsoft Windows 2000 Professional Service Pack 3

MiddleWare and Network Requirements
The appropriate RDBMS MiddleWare must be installed to enable the 
client PC to connect to the Business Objects repository and corporate 
databases. If using distributed WebIntelligence, it is recommended that 
the nodes communicate over a dedicated network to handle the extra 
network traffic.

Operating Systems
Each machine using Business Objects must be properly configured as 
described below:
¡ Each machine must have the TCP/IP network protocol installed and 

working properly.
¡ Each machine must have the appropriate network protocol for the 

database MiddleWare installed and working properly. Database 
MiddleWares may use protocols such as TCP/IP, IPX/SPX or 
NetWare.

¡ The database MiddleWare must be installed and functioning properly.



Ù»¬¬·²¹ Í¬¿®¬»¼ í

Ò±¬» Detailed information about installing TCP/IP, the database 
MiddleWare and the network protocol used by the database 
MiddleWare can be found in the administration manuals for the 
operating system and database.

CMS Requirements
CMS Release 3.4.0 or higher and current associated requirements 
(sheets).

AS/400 Requirements
The minimum AS/400 operating system requirement for RISC is release 
level V5R1.
It is highly recommended to operate at the latest AS/400 operating system 
PTF level. The chart below lists IBM PTFs by operating system. Be sure 
your operating system is running with these programs to avoid potential 
future issues.

IBM PTFs by Operating System

Ý«³«´¿¬·ª»

ÊëÎí Í×ïêìçê Ô¿¬»­¬ ½«³«´¿¬·ª» ÐÌÚ °¿½µ¿¹» ïîñðçñîððì

ÊëÎî Í×ïêïíê Ô¿¬»­¬ ½«³«´¿¬·ª» ÐÌÚ °¿½µ¿¹» ïïñïéñîððì

ÊëÎï Í×ïïèðê Ô¿¬»­¬ ½«³«´¿¬·ª» ÐÌÚ °¿½µ¿¹» ðìñíðñîððì

Ü¿¬¿¾¿­»ñÍÏÔ

ÊëÎí Í×ïêìçê Ô¿¬»­¬ ½«³«´¿¬·ª» ÐÌÚ °¿½µ¿¹» ïîñðçñîððì

ÊëÎî Í×ïêïíê Ü¿¬¿¾¿­»ñÍÏÔ ¹®±«° ÐÌÚ ïïñïéñîððì

ÊëÎï Í×ïïèðê Ü¿¬¿¾¿­»ñÍÏÔ ¹®±«° ÐÌÚ ðìñíðñîððì



ì Þ«­·²»­­ Ñ¾¶»½¬­ ëòïòç ×²­¬¿´´¿¬·±² Ù«·¼»
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Chapter 2
×²­¬¿´´·²¹ Ý´·»²¬ ß½½»­­ñ·Í»®·»­ 
ß½½»­­ Û¨°®»­­

iSeries Access Express is an IBM product that provides client/server 
capabilities for connecting PCs to iSeries servers. iSeries Access Express 
must be installed before installing Business Objects on your server.

Ò±¬» Before upgrading your current version of Client Access, open the 
ODBC Manager and delete the current Client Access, CMSFIL, 
and Repository connections.

To delete the current version of Client Access, CMSFIL, and 
Repository connections

ï On the Windows Start menu, select Control Panel, select 
Administrative Tools, and then select Data Sources (ODBC).

î On the System DSN tab, select CMSFIL, and then click Remove.



ê Þ«­·²»­­ Ñ¾¶»½¬­ ëòïòç ×²­¬¿´´¿¬·±² Ù«·¼»

í An ODBC Administrator appears, asking if want to remove the 
CMSFIL Data Source. Click Yes, and then click OK.

ì Repeat the same steps to delete the current Repository
connection.

To install iSeries Access Express

ë Insert the Client Access Express CD in your CD-ROM drive.
If the installation does not automatically begin, in Windows Explorer, 
navigate to D:\iSeries Access Original Install Programs\V5R2\
(where D:\ is your CD-ROM drive), and then double-click 
SETUP.EXE. 
The Upgrade Client Access Express message box appears.

ê In the Upgrade iSeries Access Express message box, click Yes.



×²­¬¿´´·²¹ Ý´·»²¬ ß½½»­­ñ·Í»®·»­ ß½½»­­ Û¨°®»­­ é

The Upgrade Client Access Express window opens.

é Click Next. 
The License Information window appears.

è Click Yes. 



è Þ«­·²»­­ Ñ¾¶»½¬­ ëòïòç ×²­¬¿´´¿¬·±² Ù«·¼»

The Building List of Components window displays with a progress 
indicator.

The Type of Upgrade window displays after the list of components is 
built.

ç Click Basic Upgrade. 



×²­¬¿´´·²¹ Ý´·»²¬ ß½½»­­ñ·Í»®·»­ ß½½»­­ Û¨°®»­­ ç

The Restricted Components window displays.

ïð Click Next.
The File Copy progress indicator box displays.



ïð Þ«­·²»­­ Ñ¾¶»½¬­ ëòïòç ×²­¬¿´´¿¬·±² Ù«·¼»

ïï The Start Upgrade window displays.

Uninstall Client Access Express.



×²­¬¿´´·²¹ Ý´·»²¬ ß½½»­­ñ·Í»®·»­ ß½½»­­ Û¨°®»­­ ïï

Once the files are copied, the Upgrade Completed window displays.

ïî Select the desired options and click Next. 
The Restart Computer window displays.



ïî Þ«­·²»­­ Ñ¾¶»½¬­ ëòïòç ×²­¬¿´´¿¬·±² Ù«·¼»

ïí Click Yes to restart your computer now or No to restart your 
computer later, and then click Finish.
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Chapter 3
×²­¬¿´´·²¹ ·Í»®·»­ ß½½»­­ 
Í»®ª·½» Ð¿½µ

After installing iSeries Access Express, you must install the latest service 
pack before installing Business Objects.

To download and install the iSeries Access Service Pack

ï Create a folder named Client Access Installation on the Desktop.
To do this, right-click on the Desktop, point to New, and then click 
Folder. Name the folder Client Access Installation.
This folder will contain the installation files.

î On the Start menu, point to Programs, point to IBM AS400 
iSeries Access Express, and then click Internet Information. 



ïì Þ«­·²»­­ Ñ¾¶»½¬­ ëòïòç ×²­¬¿´´¿¬·±² Ù«·¼»

The iSeries Access Express window displays.

í Click AS/400 iSeries Access in the top left corner. 
ì Depending on your iSeries Access version, click the SI number in 

the table that corresponds to your Client Access version. 
For example, if you have V5R3 loaded on your machine, click the SI 
number next to V5R3. 

Ò±¬» The service level number on the web site may be higher than what 
is listed in this example. 



×²­¬¿´´·²¹ ·Í»®·»­ ß½½»­­ Í»®ª·½» Ð¿½µ ïë

The Downloads window displays.

ë Click the .exe file. 
The File Download window displays.



ïê Þ«­·²»­­ Ñ¾¶»½¬­ ëòïòç ×²­¬¿´´¿¬·±² Ù«·¼»

ê Click Save, and then save the file in the iSeries Access Installation 
folder on your Desktop.
The Download Status window displays.

é On the Desktop, in the Client Access Installation folder, double-
click .exe file. 
In the following example, the file is named SI08894.exe.



×²­¬¿´´·²¹ ·Í»®·»­ ß½½»­­ Í»®ª·½» Ð¿½µ ïé

è In the iSeries Access Installation folder, double-click the 
Setup.exe file.

ç The iSeries Access for Windows Service Pack Installation begins. 
Click Next after this.



ïè Þ«­·²»­­ Ñ¾¶»½¬­ ëòïòç ×²­¬¿´´¿¬·±² Ù«·¼»

ïð Select Unpack the Files Used to Perform.

ïï A message box opens that prompts you that contents of this 
package are being extracted.



×²­¬¿´´·²¹ ·Í»®·»­ ß½½»­­ Í»®ª·½» Ð¿½µ ïç

The Start Copying Files window appears after the list of components 
is built.

Click Next. 
ïî The Copying Files progress indicator box displays.



îð Þ«­·²»­­ Ñ¾¶»½¬­ ëòïòç ×²­¬¿´´¿¬·±² Ù«·¼»

ïí Setup completed. Once the files are copied, the Setup Complete 
window displays.

ïì Click Yes to restart your computer now or No to restart your 
computer later, then click Finish.
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Chapter 4
Ý®»¿¬·²¹ ÑÜÞÝ Ý±²²»½¬·±²­ 
º±® É·²¼±©­ îððð ¿²¼ ÈÐ

To install Business Objects, you must first create two connections to two 
databases. The first connection is to the library where the repository will 
be installed, and is explained in "Creating a Connection to the Repository" 
on page 22. Once you have completed all the steps in that section to 
connect to the Repository, you must follow the instructions in "Creating a 
Connection to the CMSFIL Data Source" on page 29 to create the second 
connection to the CMSFIL data source.

¡ CMSFIL - Corporate database
¡ CGCUNV51 - Repository



îî Þ«­·²»­­ Ñ¾¶»½¬­ ëòïòç ×²­¬¿´´¿¬·±² Ù«·¼»

Creating a Connection to the Repository
ï On the Start menu, point to Settings, and then click Control Panel.
î On the Control Panel window, open Administrative Tools, and then 

open Data Sources (ODBC).
The ODBC Data Source Administrator opens.

In the example above, the System DSN tab is shown. Normally, when 
you open the ODBC Data Source Administrator, the User DSN tab is 
active

í On the System DSN tab, click Add.



Ý®»¿¬·²¹ ÑÜÞÝ Ý±²²»½¬·±²­ º±® É·²¼±©­ îððð ¿²¼ ÈÐ îí

The Create New Data Source window opens.

ì Select iSeries Access ODBC Driver, and then click Finish.
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The iSeries Access for Windows ODBC Setup dialog box opens.

ë In the iSeries Access for Windows ODBC Setup dialog box, on the 
General tab, perform the following:
¿ In the Data Source Name box, enter Repository.
¾ In the AS/400 System drop-down list, enter the iSeries IP 

address.
In the example above, the AS/400 System IP address is 
10.1.1.18.



Ý®»¿¬·²¹ ÑÜÞÝ Ý±²²»½¬·±²­ º±® É·²¼±©­ îððð ¿²¼ ÈÐ îë

½ Click Connection Options, and then under Default User ID, 
select Use the user ID specified below.

×³°±®¬¿²¬ Do not specify a user ID.

¼ Under Signon dialog prompting, select Prompt for 
SQLConnect if needed.

» Under Security, select Use same security as Operations 
Navigator connection, and then click OK.

ê In the iSeries Access for Windows ODBC Setup dialog box, on the 
Server tab, perform the following:



îê Þ«­·²»­­ Ñ¾¶»½¬­ ëòïòç ×²­¬¿´´¿¬·±² Ù«·¼»

¿ In the Naming convention drop-down list, select SQL 
naming convention (*SQL).

¾ In the SQL default library box, enter CGCUNV51.
½ Under Connection Type, select Read/Write (all SQL 

statements allowed).



Ý®»¿¬·²¹ ÑÜÞÝ Ý±²²»½¬·±²­ º±® É·²¼±©­ îððð ¿²¼ ÈÐ îé

¼ Click Advanced, and then in the Advanced server options
dialog box, in the Commit Mode drop-down list, select 
Commit immediate (*NONE), and then click OK.

Ò±¬» Leave all other defaults on the Advanced server options 
dialog box.

» In the iSeries Access for Windows ODBC Setup dialog box, 
on the Packages tab, clear the Enable extended dynamic 
(package) support check box.



îè Þ«­·²»­­ Ñ¾¶»½¬­ ëòïòç ×²­¬¿´´¿¬·±² Ù«·¼»

When you clear this check box, all other options on the Packages 
tab become unavailable.

é Click OK, and continue to "Creating a Connection to the CMSFIL Data 
Source" on page 29.
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Creating a Connection to the CMSFIL Data 
Source

This section explains how you create a connection to the CMSFIL data 
source after you have followed the steps in "Creating a Connection to the 
Repository" on page 22. 

To create a connection to the CMSFIL data source

ï In the ODBC Data Source Administrator, on the System DSN tab, 
click Add.
The Create New Data Source dialog box opens.

î On the Create New Data Source dialog box, select iSeries Access 
ODBC Driver, and then click Finish.
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í On the ODBC Setup window, on the General tab, perform the 
following:
¿ In the Data Source Name box, enter CMSFIL.
¾ In the AS/400 System drop-down list, enter the iSeries IP 

address.
In the example below, the AS/400 IP address is 10.1.1.18.



Ý®»¿¬·²¹ ÑÜÞÝ Ý±²²»½¬·±²­ º±® É·²¼±©­ îððð ¿²¼ ÈÐ íï

½ Click Connection Options, and then under Default User ID, 
select Use the user ID specified below.

×³°±®¬¿²¬ Do not specify a user ID.

¼ Under Signon dialog prompting, select Prompt for 
SQLConnect if needed.

» Under Security, select Use same security as Operations 
Navigator connection, and then click OK.

ì Click the Server tab, and then perform the following:
¿ In the Naming convention drop-down list, select SQL 

naming convention (*SQL).
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¾ In the SQL default library box, enter CMSFIL.

½ Under Connection Type, select Read/Write (all SQL 
statements allowed).
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¼ Click Advanced, and then in the Advanced server options
dialog box, in the Commit Mode drop-down list, select 
Commit immediate (*NONE), and then click OK.

Ò±¬» Leave all other defaults on the Advanced server options 
dialog box.

» In the iSeries Access for Windows ODBC Setup dialog box, 
on the Packages tab, clear the Enable extended dynamic 
(package) support check box.
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When you clear this check box, all other options on the Packages 
tab become unavailable.

º Click Apply, and then click OK.
When you click OK, you return to the ODBC Data Source 
Administrator, which displays the new data sources you just 
created: CMSFIL and Repository.

ë In the ODBC Data Source Administrator, click OK.
ê If open, close the Administrative Tools window.
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Chapter 5
×²­¬¿´´·²¹ Í«°»®ª·­±®ñÞ«­·²»­­ 
Ñ¾¶»½¬­

Your product key determines the modules that will be installed, which 
includes Supervisor. Also, before you install Business Objects, close all 
open applications.

To install Supervisor/Business Objects

ï Insert the Business Objects disk into your CD-ROM drive. 
The installation program automatically starts and the Welcome to 
Business Objects Setup window appears.

If the Welcome to Business Objects Setup window does not 
automatically open, in Windows Explorer, navigate to D:\Vol1\Setup 
(where D:\ is your CD-ROM drive), and then double-click Setup.exe.
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î On the Welcome to Business Objects Setup window, select 
Desktop Products, and then click Begin. 
The Installation Overview window opens.

í Click Next. 
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The User Information window appears.

ì On the User Information window, perform the following:
¿ In the Enter your full name box, enter a valid name.

In the example above, the full name is Bruce Banner and the 
organization name is Computer Guidance Corporation.

¾ In the You may also enter the name of your organization
box, enter the name of your organization, and then click Next.
The Licensing Information window opens.
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ë On the Licensing Information window, perform the following:
¿ In the Product Key box, enter a valid product key.
¾ In the Data Access Key box, enter the data access key.

The data access key is listed on the Welcome letter included with 
the Business Objects CD. As mentioned earlier, the product key 
and data access key you enter here determine which Business 
Objects modules are installed.

½ Click Next.
The Business Objects Setup - License Agreement window appears.

ê Read the Business Objects license agreement carefully, and then 
click I Agree.



×²­¬¿´´·²¹ Í«°»®ª·­±®ñÞ«­·²»­­ Ñ¾¶»½¬­ íç

The Choose Setup Profile window appears.

é On the Choose Setup Profile window, under Available Setup 
Profiles, select Stand-alone, and then click Next.
The Choose Installation Profile window appears.

è On the Choose Installation Profile window, under Available 
Installation Profiles, click Custom, and then click Next.
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The Choose Installation Folders window opens.

ç On the Choose Installation Folders window, perform the following:
¿ If you do not want to use the default folder listed, next to the 

Main Business Objects folder, click Browse, and then 
select a folder for the installation.

¾ If you do not want to use the default subfolders, click Others, 
and then select the appropriate subfolders for the installation

½ Click Next. 
ïð If the message appears stating the folder does not exist, click Yes.
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The Choose Products and Modules window appears.

Ò±¬» Your installation product key defaults to the modules your 
company purchased. Adding modules requires an additional 
product key.

ïï On the Choose the Products and Modules window, perform the 
following:
¿ Ensure that Business Objects is selected.

Depending on the product key you entered earlier, Business 
Objects should already be selected. If not, when you select 
Business Objects, you must enter the Business Objects license 
key when prompted.

¾ If you are installing to the Supervisor�s computer, ensure that 
Supervisor is selected.
Similar to Business Objects, depending on the license key you 
entered earlier, Supervisor should already be selected. If not, 
when you select Supervisor, you must enter the Supervisor 
license key when prompted.

½ Select Languages to install a different language than English 
(default) for the regional settings.
If more than one language is installed, you can select the 
interface language from within the application that you want to 
use.
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¼ Expand Data Access Packs, and then ensure that only 
Generic ODBC and DB2 are selected.

» Click Next. 
The Business Objects Setup Close Applications window displays.

Ò±¬» Do ot select the box to prompt for more recent versions of files.

ïî Click OK. 
The Business Objects Setup progress indicator appears.

All required files are copied during the installation. Do not interrupt this 
process. 



×²­¬¿´´·²¹ Í«°»®ª·­±®ñÞ«­·²»­­ Ñ¾¶»½¬­ ìí

ïí When you are prompted to view the README, click Yes to display the 
README file.

You can view related information on the Business Objects Web page. 
Go to www.businessobjects.com.

ïì Close the README.
ïë When you are prompted to check MiddleWare, click Yes. 

The MiddleWare utility checks the Business Objects drivers that were 
installed. Although this step is not required, we recommend that you 
check MiddleWare for the Client Access Connection.

ïê When the Installation was successful message appears, click OK.



ìì Þ«­·²»­­ Ñ¾¶»½¬­ ëòïòç ×²­¬¿´´¿¬·±² Ù«·¼»

Congratulations! You have successfully installed Business Objects. If 
you are a new user, we recommend you take the Business Objects 
Quick Tour located in the Business Objects folder.

ïé Close all open windows.
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Ý®»¿¬·²¹ ¬¸» Þ«­·²»­­ Ñ¾¶»½¬­ 
Î»°±­·¬±®§

The process of creating a Business Objects repository actually involves 
the following step:

ï "Creating an Empty Repository on the AS/400"
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Creating an Empty Repository on the 
AS/400

Follow the procedure below to create the empty repository to which users 
will connect.

To create the AS/400 Business Objects Repository

ï In an AS/400 session, on the Sign On screen, in the User field, 
type the user name required to access the AS/400.

î In the Password field, type the password required to access the 
AS/400, and then press Enter. 
The AS/400 Main Menu screen appears.

í On the AS/400 Main Menu screen, on the command line, type 
CRTLIB CGCUNV51, and then press Enter.

ì Leave the AS/400 session open, and continue to "Building the 
Business Objects Repository" on page 47.
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Þ«·´¼·²¹ ¬¸» Þ«­·²»­­ Ñ¾¶»½¬­ 
Î»°±­·¬±®§

ï On the Start menu, point to Programs, select Business Objects 
5.1, and then click Supervisor. 
The User Identification dialog box appears.

î The User Identification dialog box, perform the following:
¿ In the User Name box, type GENERAL.

You must type GENERAL exactly as it appears here in uppercase 
letters.

¾ In the Password box, type SUPERVISOR.
You must type SUPERVISOR exactly as it appears here in 
uppercase letters.

½ Click Admin.

Ò±¬» If you have already installed Business Objects and upgraded 
Client Access, or changed connections, you should perform a safe 
recovery.
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The Administration Setup Wizard - Welcome window appears.

í On the Administration Setup Wizard - Welcome window, click 
Begin.
The Choose Setup Configuration window opens.

ì On the Choose Setup Configuration window, select Run a safe 
recovery, and then click Click Next.

Ò±¬» If you are performing an upgrade, Run a safe recovery and then 
skip step five.
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Proceed directly to step six, on page 50.
The Define the General Supervisor window opens.

ë On the Define the General Supervisor window, perform the 
following:
¿ In the Supervisor Name box, type BACKDOOR.

You must type BACKDOOR exactly as it appears here in 
uppercase letters.

¾ In the Supervisor Password box, type backdoor.
You must type backdoor exactly as it appears here in lowercase 
letters.

½ In the Company Name box, enter the company name.
¼ Click Next.

Ò±¬» If you are performing a safe recovery, you will not see this dialog 
box.
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The Define the Repository Connection window opens.

ê On the Define the Repository Connection window, click Setup. 
The IBM Client Access for AS400 dialog box opens.

é After each transaction:
¿ Select the Advanced Tab.
¾ Select Disconnect after each transaction (do not select OK).
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½ Then, select Login.

è On the IBM Client Access for AS400 dialog box, perform the 
following:
¿ In the Database Engine drop-down list, select DB2/400V5.
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¾ In the User Name box, enter the AS/400 administrator user 
name.

½ In the Password box, enter the AS/400 administrator 
password.

¼ In the Data Source Name drop-down list, select Repository.
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» Click Test, and when the Test Connection message box 
opens, click OK to close the message box.

º On the IBM Client Access for AS400 dialog box, click OK. 
The Define the Repository Connection window opens.
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ç Click Next to begin the script execution. 

ïð On the Build the Repository screen, click Next.
The Congratulations window appears after the scripts are processed.

ïï Click Next. 
In the remaining steps, you create the BOMain key.
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The Repository Access window appears.

ïî On the Repository Access window, perform the following:
¿ Select In the LocData subfolder of the Business Objects 

folder.
¾ Accept the default key file BOMain.
½ Click Next. 

The Repository Access Complete window appears.

ïí On the Repository Access Complete window, click Finish.
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ïì Close the application.
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Granting Object Authority to the 
Repository

ï In an AS/400 session, on a command line, type GRTOBJAUT 
CGCGUNV51, and then press ENTER to grant object authority to the 
new library. 
The Grant Authority screen appears.

î On the Grant Authority screen, perform the following:
¿ In the Object field, type *ALL.
¾ In the Library field, type CGCUNV51

Ò±¬» Do not enter an asterisk in front of the library name.

½ In the Object Type field, enter *ALL.
¼ In the Users field, type *PUBLIC.
» In the Authority field, type *CHANGE.
º Leave the Authorization List and Reference Object Type

fields blank.
¹ In the Library field, type *LIBL.
¸ In the Reference Object Type field, type *OBJTYPE.
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· In the Replace Authority field, type *NO.
¶ Press Enter.

í Exit the AS/400 session.
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Ë­»®­ ·² Í«°»®ª·­±®

A Business Objects Administrator is set up using the General Supervisor 
Profile in Supervisor. All other users are set up with the Supervisor profile.
As a general rule, you should create a secondary (backup) General 
Supervisor profile in the Supervisor application. This way, in the event that 
your regular General Supervisor profile becomes disabled or corrupt, you 
can use the backup General Supervisor profile to log in with administrative 
rights.

To set up the secondary General Supervisor profile

ï On the Windows Start menu, point to Programs, point to 
Business Objects 5.1, and then click Supervisor.
The User Identification dialog box appears.

î The User Identification dialog box, perform the following:
¿ In the User Name box, type BACKDOOR.

You must type BACKDOOR exactly as it appears here in 
uppercase letters.

¾ In the Password box, type backdoor.
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You must type backdoor exactly as it appears here in lowercase 
letters.

½ Click OK. 
The Supervisor message box appears.

í Click OK. 
The Supervisor Backdoor window opens.
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ì On the User menu, point to New, and then click User.

The column on the left side of the window displays a user icon and 
positions the cursor for entry of the user ID.

ë Enter the Business Objects Administrator User ID. 

Ò±¬» This ID must match the user ID set up in CMS AS/400 Security.

ê Press Enter.
é Right-click the new user name, and then select Properties. 
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The User Properties - New User window displays.

è On the User Properties - New User dialog box, on the General
tab, perform the following:
¿ Verify the user name is correct.
¾ Accept the default Enable Offline Login and Enable Delete 

Documentation properties.
½ Do not enter a password.
¼ In the Identification Strategy drop-down list, select No 

Password Checking.
» Select other options listed per your company specifications.



Í»¬¬·²¹ Ë° Ù»²»®¿´ ¿²¼ Ò»© Ë­»®­ ·² Í«°»®ª·­±® êí

º Click the Groups and Profiles tab.

ç On the Groups and Profile tab, perform the following:
¿ Select the user name.
¾ In the Profile drop-down list, select the appropriate profile, 

and assign that profile to the Business Objects Administrator. 
This provides all access rights.
The security levels include:
¡ General Supervisor

Can create or modify the repository architecture and can 
perform any task in Business Objects.

¡ Supervisor
Has responsibility for daily administrative tasks including 
creating and managing user logins, assigning documents to 
users, and moving users between various information and 
configuration groups.

¡ Supervisor Designer
Manages Universe distribution, universe configuration on a 
user or group basis, and manages designers.

¡ User
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Can access user modules within Business Objects.
¡ Versatile

Can access modules defined by a supervisor.
½ Click OK. 

The Business Objects Administrator with the General Supervisor 
profile is now available.

ïð Repeat the process to add additional users giving them the 
appropriate security levels.
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Resetting the Database Engine (for 
Upgrades Only)

Ò±¬» You should only need to reset the database engine versions if you 
upgrade Client Access to 5.1 to iSeries Access V5R2, or if you 
upgrade the AS/400 to V5R2 or later. 

Resetting the Database Engine for the Repository 
Connection

ï On the Start menu, point to Programs, select Business Objects 
5.1, and then click Supervisor. 

î The User Identification dialog box, perform the following:
¿ In the User Name box, enter the appropriate Supervisor user 

name.
¾ In the Password box, the appropriate Supervisor password.
½ Click OK. 

The Supervisor message box opens.

í Click OK. 
ì On the Tools menu, click Connections. 
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The Connections dialog box opens.

ë Select CMSFIL, and then click Edit. 
ê Continue to "Resetting the Document and Universe Engines" on 

page 67.
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Resetting the Document and Universe Engines

Ò±¬» You should only need to reset the database engines if you upgrade 
Client Access V5R1 to iSeries Access V5R2, or if you upgrade the 
AS/400 to V5R2 or later. 

To reset the document and universe engines

ï In Supervisor, on the Tools menu, click Repository.
The Repository Management dialog box appears.

î Select Document, and then click Modify.
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The Define Repository Connection window opens.

í Click Setup. 
The IBM iSeries Access for AS400 dialog box opens.

ì In the IBM iSeries Access for AS400 dialog box, perform the 
following:
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¿ In the Database engine drop-down list, select DB2/400 V5.
¾ Ensure that the Use BusinessObjects user name and 

password check box is selected.
½ In the Data source name box, select Repository, and then 

click OK.
ë On the Define Repository Connection window, click Finish.

When you click Finish, you return to the Repository Management 
dialog box.

ê On the Repository Management dialog box, select Universe, 
and then click Modify.
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The Define Repository Connection window opens.

é Click Setup. 
The Client Access Login dialog box opens.

è In the IBM iSeries Access for AS400 dialog box, perform the 
following:
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¿ In the Database engine drop-down list, select DB2/400 V5.
¾ Ensure that the Use BusinessObjects user name and 

password check box is selected.
½ In the Data source name box, select Repository, and then 

click OK.
ç On the Define Repository Connection window, click Finish, and 

then close Supervisor.
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Ý®»¿¬·²¹ ¿ Í»½«®»¼ Ý±²²»½¬·±² 
¬± ÝÓÍÚ×Ô

Before you can install universes, you must create the connection to 
CMSFIL, which is explained in "Creating the Connection to CMSFIL" on 
page 74.
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Creating the Connection to CMSFIL
You only need to create the connection to CMSFIL if it does not already 
exist. If you are not sure if it already exists, perform step 1 below.

To create the connection to CMSFIL

ï Open Supervisor

î Select Tools
í Select Connections
ì In Supervisor, on the Tools menu, click Connections. 
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The Connections dialog box opens.

In this example, in the Available Connections area, CMSFIL is listed. 
If CMSFIL already exists in your list of available connections, you can 
close this dialog box and skip ahead to "Close Supervisor." on page 
78. If CMSFIL does not exist in the list, then continue to step 2 below.

ë In the Connections dialog box, click Add.
The Add a connection dialog box opens.
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ê In the Add a connection dialog box, in the list of network layers, 
select IBM Client Access for AS400, and then click OK.
The IBM Client Access for AS400 dialog box opens.

é In the IBM Client Access for AS400 dialog box, on the Login tab, 
perform the following:
¿ In the Database engine drop-down list, select DB2/400 V5.
¾ Select Use BusinessObjects user name and password.

When you select Use BusinessObjects user name and password, 
the User name and Password boxes in the IBM Client Access for 
AS400 dialog box become unavailable.

½ In the Data Source name drop-down list, select CMSFIL 
Connection.
The Type drop-down list should be Secured.

¼ Click Test to test the connection. 
» Select Advanced Tab
º Select Disconnect After Each Transaction.
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¹

The Test Connection message box opens.

¸ Click OK, and then in the IBM Client Access for AS400 dialog 
box, click OK.
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è In the Connections dialog box, in the Available Connections list, 
ensure that CMSFIL is listed, and then click OK.

ç Close Supervisor.
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You install and update universes for Business Objects from the Computer 
Guidance web site at www.computer-guidance.com. 

The process of installing universes actually involves two steps

ï You must first download the universes from the Computer 
Guidance Corporation web site (see "Downloading Universes" on 
page 70).

î Then you export the universes (see "Installing Universes" on page 
76).

To download universes

ï On the Computer Guidance Corporation home page, on the
Customers menu, point to Product Support, and then select 
Business Intelligence.
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The Login to Computer Guidance Corporation page appears.

î On the Login to Computer Guidance Corporation page, perform 
the following:
¿ In the Username/Customer Number box, enter the BusObj 

customer number. 
¾ In the Password/Zip Code box, enter the Zip code. 
½ Click Login.
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The Customer Center page appears.

¿ Scroll to the Products Update dialog box.
On the Customer Center page, when you scroll down, the universes 
are listed with the last date they were updated.



èî Þ«­·²»­­ Ñ¾¶»½¬­ ëòïòç ×²­¬¿´´¿¬·±² Ù«·¼»

í On the Business Intelligence Support page, click the appropriate 
universe you want to download.

Ò±¬» You can download universes only for the modules purchased. 

The Employee Universe page opens. 

ì On the Employee Universe page, perform the following:
¿ In the Customer Number box, enter the customer number.
¾ In the Email Address box, enter an email address.
½ In the Contact Name box, enter a contact name.
¼ Click Submit. 
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The Employee Universe - Installation Instructions page opens. 

ë On the Employee Universe - Installation Instructions page, 
perform the following:
¿ Review the information.
¾ Click the appropriate Universe icon.
½ In the File Download dialog box that appears, select Save 

this program to disk, and then click OK. 
¼ In the Save As dialog box that opens, navigate to the 

Universe folder under Business Objects, and then click 
Save. 
A progress indicator window opens showing the files being 
copied. 
For example, save each universe to C:\Program Files\Business 
Objects\Business Objects 5.1\Universes.

» Repeat steps 3 through 5 for each universe.
Once saved to the Universe folder, you need to export each 
universe one at a time.
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Although you can select all the universes and it appears they 
were successfully exported, only the first universe actually 
exports if you select more than one to be exported.

ê Continue to "Installing Universes" on page 84.

Installing Universes
ï If Supervisor is not already open, on the Start menu, point to 

Programs, point to Business Objects 5.1, and then click 
Supervisor. 
The User Identification dialog box appears.

î In the User Identification dialog box, perform the following:
¿ In the User Name box, enter a valid Supervisor user name.
¾ In the Password box, enter a valid Supervisor password, and 

then click OK.
í On the Supervisor window, on the Tools menu, click Export 

Universes.
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The Export Universe dialog box opens.

ì In the Export Universe dialog box, click Add.
The Universe to Export dialog box opens.

ë In the Universe to Export dialog box, select the Universe to export, 
and then click Open.
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The Export Universe dialog box opens.

ê In the Export Universe dialog box, click Parameters.
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The Universe Parameter dialog box opens. 

é On the Universe Parameter dialog box, in the Connection drop-
down list, select the CMS default library, and then click OK.
In the example above, the default library is CMSFIL.

Installing Business Query
Business Query is installed using the Business Query product key (the 
same process as a Business Object key).
ï After Business Objects is installed on a user machine (using the 

Business Query product key), open Excel.
î On the Tools menu, click Addins.
í In the Addins dialog box, click Browse.
ì Navigate to Business Objects | Business Objects 5.1
ë Locate and double-click the bqapi.xll file.

Note that Business Objects 5.1 was added to the addins list.
ê Click OK. 

Business Query is now part of the menu bar.
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In order for all users to access Business Objects, the domain connections 
names must be changed using Supervisor.
The following process is completed for both the Document and the 
Universe domains.  Once the Document domain has been setup, repeat 
these steps to setup the Universe domain.
ï Open Business Objects Supervisor, and select the Repository

icon.
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î The Repository Management screen appears.

Select the Document domain, and then click Modify.
í The Define the Repository Connection screen appears.

Click Setup.
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ì The IBM Client Access for AS400 screen displays.

¿ For the Database Engine, select DB2/400 V5 from the drop-
down menu.

¾ Then, check Use Business Objects user name and 
password.

½ Leave the User Name and Password areas blank.
¼ In the Data Source Name drop-down menu, select 

Repository, and then click OK.
» Disconnect after each transaction:

¡ Select the Advanced Tab.
¡ Select Disconnect after each transaction (do not select ok).
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¡ Select Login.

ë The Define Repository Connection screen displays.

¿ Click Finish.
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¾ Go back to page __ and repeat this process for the "Universe 
Domain.

½ Close Supervisor.
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Security Domain Setup
When the Document and Universe domains are set up in the Repository, 
you must set up the Business Objects security domain to ensure security.

To set up the Security Domain:

ï Open Windows Explorer, navigate to C:\Program 
Files\Business Objects\Business Objects 5.0\LocData, and 
then open LocData.

¿ Delete the BOMain.key or create a backup.
¾ Then delete BOMain.lsi and Workgroup.lsi.
½ Close Windows Explorer, and then open Supervisor.



Í«°»®ª·­±® Ü±³¿·² Í»¬«° çë

î In the Supervisor User Indentification window, enter GENERAL
(in all caps) for the User Name and enter SUPERVISOR (in all 
caps) for the Password. Then, click on Admin.

í The Welcome to Administration Setup screen displays.

Click Begin.
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ì The Choose Setup Configuration screen appears.

Select Run a Safe Recovery, and then click Next.
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ë The Define Repository Connection screen appears.

Click Setup.
ê The IBM Client Access for AS/400 screen appears.
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¿ For the Database Engine, select DB2/400 V5 from the drop-
down menu.

¾ Then, check Use Business Objects user name and 
password.

½ Leave the User Name and Password areas blank.
¼ In the Data Source Name drop-down menu, select 

Repository, and then click OK (do not test).
é The Define Repository Connection screen appears.
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Click Next.

Ò±¬» No repository checking is done when variables are used for the 
connection displays.  This indicates that security will not be 
checked at the Business Objects level.

Click OK.
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è The Define Repository Access screen appears.

¿ Click on In the LocData subfolder of the Business Objects 
folder.

¾ Verify the key file name is BOMain, and then click Next.
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½ The Repository Access screen displays indicating that the 
BOMain.key file was created successfully.

ç The Supervisor User Identification screen opens.

¿ Use your current User Name and Password to open 
Supervisor, and then click OK.
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¾ Login into Supervisor, and then verify the Security Domain.

½ Select the Repository icon.
ïð The Repository Management screen displays.
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¿ Place your cursor at the right edge of the Connection Bar 
(circled).  When the cursor changes to double arrows, double 
click on it.

¾ Select the Scroll Bar and slide to the right.
½ Make sure that all the domains display as listed below:

¡ Business Objects Security Domain:  
Repository;ODBC_USER=@variable('BOUSER');ODBC_P
ASSWORD=@variable ('BOPASS');
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¡ Document Domain: 
Repository;ODBC_USER=@variable('BOUSER');ODBC_P
ASSWORD=@variable ('BOPASS');

¡ Universe Domain:  
Repository;ODBC_USER=@variable('BOUSER');ODBC_P
ASSWORD=@variable ('BOPASS');

¼ If all of the domains are displayed correctly, click OK.
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Chapter 12
Changing Business Objects Default 
Settings

To be able to drill down between summary and detail files, you must 
change three Business Object defaults, which are explained below.

To change Business Object defaults

ï In Windows Explorer, navigate to DB2400EN.prm.
Typically, the path is C:\Program Files\Business Objects\DataAccess 
5.0\DB2\DB2400EN.prm.

î In Microsoft Notepad, open DB2400EN.prm, and then change the 
following:
OWNER=N
GROUPBY_EXCLUDE_COMPLEX=N

í On the File menu, click Save.
ì In Microsoft Notepad, open DB24V4EN.prm.

Typically, the path is C:\Program Files\Business Objects\DataAccess 
5.0\DB2\DB24VEN.prm.

ë Change the following:
OWNER=N
GROUPBY_EXCLUDE_COMPLEX=N 

ê On the File menu, click Save, and then close Notepad.
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Appendix A
Installing Business Query

Business Query is installed using the Business Query product key (the same process as a Business 
Object key).

é After Business Objects is installed on a user machine (using the Business Query product key), 
open Excel.

è On the Tools menu, click Addins.
ç In the Addins dialog box, click Browse.
ïð Navigate to Business Objects | Business Objects 5.1.
ïï Locate and double-click the bqapi.xll file.

Ò±¬» Note that Business Objects 5.1 was added to the addins list.

ïî Click OK.

Business Query is now part of the menu bar.
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